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Creating Accessible Documents in
InDesign Overview

An accessible document is one that is optimized for screen readers and other assistive technology
devices used by persons with disabilities. Achieving this kind of accessibility requires:

» Tagging all document content based on its hierarchical structure (i.e., headings, paragraphs,
lists, tables, etc.).

» Ordering content in a linear path from start to finish.
» Adding alt text for all non-text content, such as images and graphics.

Adobe InDesign offers a direct workflow (listed below) that dramatically reduces the time and effort
required to produce accessible PDF documents.

The remainder of this document breaks down each of these steps. To quickly navigate the document,

» Select the steps below to go directly to more information about that step.
» Scan or select the QR code to watch a video about that step.
» Use bookmarks to navigate between sections of the document.

Steps For Creating an Accessible PDF

Use paragraph styles consistently throughout your document.

Establish export tag relationships between InDesign styles and PDF tags.

Add alt text for meaningful images and graphics.

Incorporate internal navigation mechanisms, such as hyperlinks and
bookmarks.
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https://youtu.be/COcJNJ83V1E
https://youtu.be/zDhAuMK83zE
https://youtu.be/ekXj05gJW0o
https://youtu.be/fy9o4mQyqjA

Establish content order in the Articles panel.

Add a document title as metadata.

Export the document as a PDF with settings optimized for accessibility.

Finalize the document in Adobe Acrobat Pro.
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https://youtu.be/8fRHZtqmAlQ
https://youtu.be/MZtktKTJIrQ
https://youtu.be/r8Qv7yl1v1k
https://youtu.be/CIm8cVlKsDA

Step 1: Use Styles Consistently

Consistent use of InDesign styles through a document is critical for efficiently and successfully
exporting the content to an accessible PDF.

What Are Styles?

In InDesign, there are five different types of styles you can use when creating documents. These
include:

» Paragraph Styles: Sets both character and paragraph formatting.

» Character Styles: Applies formatting to words and individual characters.

» Object Styles: Standardized formatting across shapes and frames, such as strokes and drop
shadows.

» Table Styles: Standardized table formatting throughout your document.
» Cell Styles: Works within Table Styles to standardize cell text, fills, and strokes.

The Instructional Design team has set up each type of style in your InDesign templates. Using these
styles keeps your formatting clean, consistent, and easy to update.

Paragraph Styles vs. Character Styles

Paragraph styles and character styles serve different but complementary purposes when formatting
text.

You'll use paragraph styles when:

» You want to apply formatting to an entire paragraph, including:
Text font, size, and color.
Alignment and spacing.
Indents and tabs.
Hyphenation.
» You're working with structured content, like headings, body text, or lists.
» You want to maintain a consistent layout and hierarchy across a document.

You'll use character styles when:

» You want to format specific words or phrases within a paragraph.

» You need to apply emphasis (i.e., bold, italic, color) without changing the paragraph’s overall
style.

Think of paragraph styles as your document’s foundation, and character styles are used for emphasis.
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Setting Up & Editing Paragraph Styles

While paragraph styles have been set up for you in your template, you may need to adjust styles or
add new ones. To create new paragraph styles (instructions for the Essentials Classic Workspace):

1. Go to the Properties Panel on the right side of your
workspace.

Properties

Text Insertion 2. Make sure Paragraph Styles is selected under Text Style.
3. Click on the +icon.

Character Styles

s

4. Name the paragraph style.

Ag Numbers - Level 1

5. Set the basic formatting options, including:
a. Basic Character Formats: Set the font, font style, size, and case.

b. Indents and Spacing: Set the text alignment, left and right indents, and the space before
and after a paragraph.

c. Hyphenation: Turn off hyphenation by deselecting the check box.

d. Bullets and Numbering: Define bulleted and numbered lists, select bullets, and set list
hierarchy.

e. Character Color: Set the text color.
f. Export Tagging: Set export tags as needed (export tagging explained more in step 2).
6. Select OK to create the new paragraph style.

Paragraph Style Options

GESSNeNE [No Paragraph Style] -
LES=E [Same style]

Shortcut:

( Reset To Base )

[Na Paragraph Style] + next: [Same style] + Gotham + Book - hyphenation + space after; 0.125 in
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When you edit a paragraph style, InDesign will apply those changes everywhere that style is used.
This makes it quick and easy to make formatting changes to your document.

To edit paragraph styles:

==

Go to the Properties Panel on the right side of your workspace.
Make sure Paragraph Styles is selected under Text Style.

Click on the down arrow icon next to the paragraph styles name.
Hover over the paragraph style you want to edit.

Select the pen (edit) icon.

Update the desired formatting options.

No gk wbd =

Select OK to save changes to the paragraph style.

Ag [Basic Paragraph]

Ag Body Text

Document Title - T@ 4
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Step 2: Establish Export Tag

Relationships

Defining export tags in a paragraph style creates an association between the text using that style
and its role in the semantic structure of the PDF document. You can set any paragraph style to one of

eight basic PDF tags.

PDF Tag Applied to...
<P> Body text
<H1> through <H6> A heading that reflects the document’s organization hierarchy
<Artifact> Any page content that the screen reader should ignore

Tables, bulleted lists, and numbered lists are recognized automatically in the export process and are

tagged appropriately.

Setting Up Export Tags

If you create your own paragraph styles, you may need to establish your own export tags. To do this:

H N =
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Open the Paragraph Style Options dialog box.
Navigate to Export Tagging.

In the PDF section, assign the export tag.
Select OK to save and close the dialog box.




Step 3: Add Alt Text

All meaningful images and graphics in an accessible instructional document require alt text.
Decorative images, or images that provide no important information and are for visual purposes
only, should not have alt text and should be either removed from the reading order or marked as and
artifact.

Note: If the text adjacent to the image or graphic describes the graphic, you do not need to add alt
text.

You can add alt text in InDesign using Object Export Options:

Select Object from the top menu bar.

Select Object Export Options.

Select the graphic or image to which you want to add alt text.
Next to Alt Text Source, select Custom.

Enter the alt text.

a M e n -

When added correctly, alt text will appear as a tool-tip when the user hovers over an image in the final
PDF.

File Edit Layout Objec able \iew Plug-Ins Window 0
Iransform ]
= Tagged PDF EPUB and HTML
o T Transform Again H
\ Arrange » Alt Text Source:  Custom
Select ]
for Accessibility Werkflows i
0 1/2
Lock Ctri+L
Insert MathML...
Generate OR Code...
Extract from Image >
Text Frame Options... Ctri+B
Anchored Object ¥
Fitting >
Content »
Effects ]

Object Export Options...

Clipping Path y
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Tips & Tricks For Adding Alt Text in InDesign

» You can leave the Object Export Options dialog box open while you work, eliminating the need
to repeatedly close and reopen it for each image.

» Group graphics together (like the screenshot with the call-out box and numbers). Then, add
alt text to the group instead of to each image individually. This will make it easier to add the
images to the reading order in step 5.

» If you have a repeated graphic that will all have the same alt text, you can create an object style
for that graphic. Add the alt text to the object style and it will apply each time you apply that
object style.

» Add alt text to images after you have finished typing and arranging your document in InDesign.
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Step 4: Incorporate Internal
Navigation

Bookmarks and hyperlinks are conveniences to sighted users but are also essential navigation
tools for the visually impaired. These navigation mechanisms are the means by which users with
disabilities move through a document and get an overview of its content and organization.

Bookmarks

You can arrange bookmarks hierarchically in the Bookmarks panel and nest specific bookmarks under
broader categorical bookmarks for a clearer indication of a document'’s distinct sections.

To add bookmarks:

Bookmarks 1. Select Window from the navigation bar at the top of the screen.

5 o 1< e P Aot o 2. Hover over Interactive. Then, select Bookmarks.

«l» Step 2: Establish Export Tag Relationsh... 3

. Highlight the text you want to bookmark. These are typically the major
. Step 4 Incarporae Internal Vavig.. headings in your document (heading levels 1-4).

4. To nest bookmarks based on the document hierarchy: Select the
heading that the next bookmark should be nested within.

5. Select the + icon at the bottom of the window to create a bookmark.

When exported to PDF with the proper settings, the InDesign bookmarks and their organization
structure are matched exactly in the Acrobat Bookmarks pane and work as clickable links to the
appropriate content.

Bookmarks 2 x Bookmarks L/ 1
I Objective

v . Accessible Content Design Objective T@J'

“ [, Creating Hierarchical Structures

¥ 3 ~  Accessible Content Design
ol Best practices

s Examples of heading levels in ... % Creating Hierarchical Structur.

J. Pay attention to Lang

' . . Best practices for creating
s Inclusive language dos & don'ts
structural elements:
J: Readability
» s Using Altemative Text (Alt Text) Examples of heading levels
£ Tips for writing alt text in @ document:
£ At text examples 5 Pay Attention to Language
Bookmarks in Bookmarks in
InDesign Acrobat
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Hyperlinks

Hyperlinks, either to external locations like websites or to in-document locations like text anchors,
provide additional navigation points on a more micro level. PDF links are created upon export for links
created in the Hyperlinks panel.

Creating hyperlinks with text anchors:

You can create hyperlinks to in-document locations using text anchors. This is especially helpful for
creating internal navigation, like a clickable table of contents.

Creating text anchors allows you to link to a specific point in the document, such as a heading,
paragraph, or even a word, so that when someone clicks the hyperlink, they're taken directly to that
spot.

To create text anchors for hyperlinks:

—z ’- 1. Select Window from the navigation bar at the top of the

screen.
o L e 2. Hover over Interactive. Then, select Hyperlinks.
9 : e 3. Highlight the text you want to anchor. Those are typically
Mew Hyperlink Destination... . . .
the major headings in your document.
e e SO, 4. Select .the menu icon in the top right corner of the
Delete Unused Destinations Hype”lnks panel-

5. Select New Hyperlink Destination.

Sort »

Small Panel Rows

¢ Auto Update URL Status

6. Name the text anchor.

« If you will have a lot of text anchors, we recommend naming them so they can be easily
grouped within their hierarchy. For example, in this document, you could name them: “00
Introduction,” “01 Step 1, “01 What are Styles,” etc.

7. Select OK to save the text anchor.

r MNew Hyperlink Destination ]

Type: Text Anchor

6 MName: Introduction
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To create the hyperlink:

Hyperiinks Buttons: Bookmar > 1. Select Window from the navigation bar at the top of the
: : screen.

URL:  http:/
2. Hover over Interactive. Then, select Hyperlinks.
3. Highlight the text you want to make a link.

4. Select the + icon at the bottom of the hyperlinks panel.

5. Select Text Anchor from the drop down menu next to Link To.
6. Under Destination, select the desired text anchor from your document.
7. Set the desired character style.
Use Hyperlink for in-line links.
+ Use Same Style for any links in a table of contents.
8. Select OK.

MNew Hyperlink

5 Link To: | Text Anchor - I

Destination

( Cancel )

Text Anchor: 03 Step 2: Estabhish Export ...

Character Style

EEH Hyperfink

PDF Appearance

Type: Invisible Rectangle

Higllight:  MNoiwe

Best practices for using hyperlinks:
» Use descriptive link text. Avoid vague phrases like “click here” or “read more.” Instead, use
more meaningful descriptive text that clearly indicates the link’s destination.

» Avoid using URLs as link text. Screen readers often read out each character in a URL, which
can be confusing and time-consuming. Instead, embed the URL behind descriptive text.

» Maintain proper contrast ratios. Hyperlinks should have a color contrast ratio of at least
4.5:1 against the background color and should not rely on color alone to indicate interactivity.
Underlining links is a common visual cue.
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Step 5: Establish Content Order in
the Articles Panel

The tagging order of a PDF document is essential to its readability. The Articles panel in InDesign
enables you to precisely define which content in your document gets tagged and in what order.

Note: Complete this step only after finalizing all content and edits in your document.

To add content to the Articles panel:

- Articles 1. Select Window from the navigation bar at the top of the screen.
No content. Drag stories and objects here to 2. Select Articles.

Article and to it. Or,
Add content (including all text frames and any graphics or images
with alt text) to the Articles panel by either:

-click the Add button to add all dm::ment. 3
content at once to 3 new or selected Article. .
« Dragging and dropping content into the Articles panel.

+ Selecting multiple items (in the order you want them to be
read), then selecting the + icon.

Note: Any images that are purely decorative can be left out of
the Articles panel.

Unassigned page Item

4. When prompted, give your article a name or keep the default.
5. Make sure Include When Exporting is checked (this is usually checked by default).
This setting ensures the article is tagged and ordered correctly when exported to a PDF.

6. If needed: Reorder items in the Articles panel by dragging items up or down within the articles
panel to set the reading order (top to bottom).

7. For more complex or long documents, use multiple articles.

8. Select the menu at the top of the Articles panel. Make sure Use for Tagging Order in Tagged
PDF is selected.

Mew Article

New Article...

9 Include When Exporting
HTML. In Tagged POF, content

reading -u-rdef mII-L\e based on the Article's order.

Ce ) [

Use for Tagging Order in Tagged PDF
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Step 6: Specify the Document Title
as Metadata

For accessibility, a PDF title requires a document title. When you save this information in the file
information in InDesign, it is automatically transferred to Acrobat as required metadata.

To add a title to the document file:

1. Select File from the navigation bar at the top of the screen. Then, select File Info.
2. Add the title of the document.
3. Select OK.

Layout Type Object

Open.. Ctrl+0 Basic
Browse in Bridge.. Ctri+Alt+0 Camera Data

Open Recent > Origin of commas can be used to separate multiple
Close Ctrl+W IPTC

Save Ctrl+S 1PTC Extension Author Title:
Save As. Ctrl+Shift+5 GPS Data

Audio Data

Save a Copy... Ctri+Alt+S Video Data

Revert Photoshop

co
Search Adobe Stock.. DICOM Description

Place.. Ctri+D pext P.rr.-p-?mes Keywords:
Place from CC Libraries... Row Uzt
Text to Image
Import XML...

Import PDF Comments...

Adobe PDF Presets »
Export.. Ctrl+E
Invite to Edit...

Unknown

Share for Review...

Export to Adobe Express

Publish Online...
Publish Online Dashboard...

Document Presets >
Document Setup... Ctri+Alt+P :
’ (Windows)
Adjust Layout... Alt+Shift+P .

Format: on/x-indesign

File Info... Ctri+Alt+Shift+l

Package.. Ctrl+Alt+Shift+P
Print Presets >
Print... Ctri+P
Print Booklet..

) ( Preferences ) Template... 3 DK Cancel )
Exit Ctrl+Q S i Tt ta—
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Step 7: Optimize the Export
Settings For Accessibility

When you are exporting your document as a PDF, make sure you have selected the following:

» Under the General settings:
« Under Options, select Create Tagged PDF.
* Under Include, select Bookmarks and Hyperlinks.
» Under Advanced settings, go to the Accessibility Options:
+ Set the Display Title to Document Title.
« Select the language for the document.

Export Adobe PDF Export Adobe PDF

Adobe PDF Preset: [High Quality Print] (modified) Adobe PDF Preset: [High Quality Print] (modified)

Standard: Compatibility: Acrobat 5 (FDF 1.4) Standard: None Compatibility: Acrobat 5 (PDF 1.4)

- - Com
Rrers e [Based on THigh Quaity P Use these settngs to create Adobe PDF S

Mark eed documents for quality prnting on desktop printers and proofers. Created d et et = of characters used is less tha 100%
PDF documents can be opened with Acrobat and Adobe Reader 5.0 and Subset fonts when haracters used is less than: 100%
A 4 e 1) Al fonts with appropriate e s ¢ embedded

Fonts
Output

= .
o Pages Viewing OP1

O Al Range: 2 View: Default Omit for OF1: [ EPS [0 PDF [ Bitmap Images
Export As © Pages Spreads Layout: Single Page Cortinuous
[] Create Separate PDF Files | Open in Full Screen Made
View PDT after Exporting
Options Accessibility Options

["] Embed Page Thumbnails Create Tagged PDF Display Title: cument Titl

Optimize for Fast Web View Language: English

rs:  Visible & Printable Layers

Hover over an option to view description.

Include
Bookmarks [ Non-Printing Objects

Hyperlinks [ visible Guides and Baseline Grids

Do Not Include

( Bwpor ) ( Cancel ) ( ) ( Bpor ) ( Cancel
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Step 8: Finalize the Document in
Acrobat Pro

The tags created in InDesign carry over to the PDF, but you need to explicitly tell Acrobat to use these
tags for the reading order and accessibility.

To use the order specified by the InDesign’s document structure:

Select all the pages in the Acrobat’s Page Thumbnail pane.
Select Page Properties from the Options menu.

Select Use Document Structure for the tab order.

Select OK.

Save the PDF document so the changes apply.

x Pages o = FaN D;-

Insert Pages... >

a > w2

-3

Page Properties

:
[

Extract Pages... @  Tab Order | Actions
Replace Pages... L—JE
Use Row Order

Delete Pages...

I Use Column Order
Crop Pages... 0
Rotate Pages... z 9 © Use Document Structure
Page Transitions... Unspecitied

Choose one of the above options to
Copy set the order for tabbing through
items on a page.

Page Labels...

Print Pages...

Canceo -:I-
Embed All Page Thumbnails

Remove Embedded Page Thumbnails

Reduce Page Thumbnails

Enlarge Page Thumbnails

q Page Properties...
B I
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